Movavi Screen Recorder 10

Don't know where to start?
Read these tutorials:

**Recording screen**
Capture any fragment of your screen or the full desktop.

**Recording Skype calls**
Record Skype calls with sound from both ends.

**Recording online video**
Record video from online video websites such as YouTube or Vimeo.

**Recording only audio**
Record any sound from a device or music on your computer.

**Recording video from players**
Record any video in your player.

Need more help?
Write to us at support@movavi.com
Or click here to open live chat.
# Table of Contents

Activating Screen Recorder ................................................................. 3
  Activating without Internet access .................................................. 4
  Getting an activation key .................................................................. 6
  Trial limitations .............................................................................. 7
Recording video from screen ............................................................... 8
Recording online video ..................................................................... 11
Recording with webcam .................................................................... 13
Recording video from players .......................................................... 15
Recording Skype calls ...................................................................... 18
Making an animated GIF ................................................................... 20
Record audio only .......................................................................... 22
Setting up a screen recording ............................................................ 24
  Capture area .................................................................................. 26
  Sound ............................................................................................ 28
  Webcam ........................................................................................ 30
  Mouse cursor effects .................................................................... 31
  Recording keystrokes .................................................................... 33
  Scheduling .................................................................................... 34
  Time limit ..................................................................................... 36
  Starting the recording ................................................................... 38
Editing captured files ........................................................................ 40
  Opening the player ....................................................................... 41
  Opening previous recordings ........................................................ 42
  Cutting recordings ........................................................................ 44
  Changing the format ...................................................................... 46
  Advanced settings ........................................................................ 47
  Uploading videos to YouTube ....................................................... 49
  Uploading videos to Google Drive ............................................... 52
  Uploading videos to Movavi Cloud ............................................... 55
Taking screenshots ........................................................................... 57
Screen Recorder preferences ............................................................. 59
  General preferences ................................................................. 60
  File preferences ........................................................................... 62
  Keyboard shortcuts ...................................................................... 63
  Video preferences ........................................................................ 64
  Webcam preferences ..................................................................... 65
  Effects ......................................................................................... 66
  Scheduler .................................................................................... 67
  Sharing preferences ..................................................................... 68
Help and support ............................................................................. 69
  Codec activation .......................................................................... 71
  Supported formats ........................................................................ 72
  Updating the graphics card driver ............................................... 73
  OpenGL troubleshooting ............................................................. 75
  How to collect logs ...................................................................... 76
Activating Screen Recorder

Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Step 2: Click Help and select Activate Software.

Step 3: Enter your activation key and click Activate.
Activating without Internet access

If your computer is not connected to the Internet, you can activate Movavi Screen Recorder via e-mail.

**Step 1:** Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

![Buy Activation Key Button]

**Step 2:** Click Help and select *Activate Software*.

**Step 3:** Enter your activation key and select the *Activate offline* option. Then, click *Activate*.

**Step 4:** In the next window, click *Copy* and transfer this information to a computer or device with an Internet connection.

**Step 5:** When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should receive a reply within an hour. Copy the *registration key* from the reply and transfer it to the computer with Movavi Screen Recorder.
Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you used before. Then, paste the registration key into the box and click Activate.
**Getting an activation key**

To activate Movavi Screen Recorder, you will need an activation key. You can buy an activation key from our official website or from any of our partners, and it will be delivered to you via e-mail.

1. In the program menu, click Help and select **Buy Activation Key**, or use the button below.

![Buy Activation Key](button)

2. On the purchase page, click the **Buy Now** button next to the product that you need.

3. Fill in your billing information and enter a valid e-mail address. **IMPORTANT!** We will send the activation key to this e-mail address, so please make sure it is entered correctly.

4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail from support@movavi.com with your **activation key**.

If you haven't received your activation key:
- Check the Spam folder of your mailbox
- Contact support
Trial limitations

When you first start your copy of Movavi Screen Recorder, it will be running in **LIMITED TRIAL MODE** until you activate the program. You can use all the features, but the following restrictions will apply:

<table>
<thead>
<tr>
<th>TRIAL VERSION</th>
<th>FULL VERSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movavi Screen Recorder will stop working after 7 days</td>
<td>✔️ Lifetime license</td>
</tr>
<tr>
<td>A watermark with the words ‘trial version’ will be added to all exported videos</td>
<td>✔️ No annoying watermarks</td>
</tr>
<tr>
<td>Capture time is limited to 5 minutes per video</td>
<td>✔️ Unlimited capture time</td>
</tr>
<tr>
<td>You can only finish recording manually</td>
<td>✔️ Set time limit during recording</td>
</tr>
<tr>
<td></td>
<td>✔️ Free updates</td>
</tr>
<tr>
<td></td>
<td>✔️ Discounts on other Movavi products and upgrades</td>
</tr>
</tbody>
</table>
Recording video from screen
How to make a screencast with Movavi Screen Recorder

This tutorial will show you how to record and save a video from what’s happening on your screen.

Step 1: Set up the capture area
1. On the recording panel, click the Select capture area button.
2. Select the part of the screen that you want to record:
   • Click and drag on the screen to select the capture area.
   • To record a window or a window panel, hover your mouse pointer over it and click once a frame appears around it.
   • To record the full screen, click the full screen button.

Step 2: Set up the sound
Recording system audio
1. Click the System Audio button to enable recording sounds and audio playing on your computer.
2. Use the slider on the left to set the necessary recording volume.

Recording from a microphone
1. Make sure that a microphone is connected to your computer.
2. Click the Microphone button to enable recording sounds from external devices.
3. Click the arrow above the Microphone button and select the device you want to use for recording.

Step 3: Start recording
When you’re ready to begin, click the REC button. You will be given a 3-second countdown before the recording begins.

Use these keyboard shortcuts to control the recording process:
F9 - pause the recording
F8 - take a snapshot of the capture area
F10 - end capture and save the recording

Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the preferences.
When you're ready to finish your recording, click **Stop** on the recording panel or use the **F10** keyboard shortcut.

**Step 4: Edit the recording (optional)**
When you finish recording, the capture editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or save it in a different format.

**Cutting the recording**
To cut out a fragment:
1. Place the position marker to the beginning of the unwanted fragment and click the **scissors** icon.
2. Move the position marker to the end of the fragment and click the **scissors** button again.
3. Move the position marker to the center of the fragment to select it and click the **trash can** button.

**Saving the edited recording**
To save the trimmed version, or to change the format of your recording:
1. Click the **Save As** button. The output options will open.
2. Choose a name and location for saving the video.
3. Click one of the squares to choose a format for saving your video.
4. Click **Save** to start processing your recording.
Frequently asked questions

I get a codec activation message when I try to start recording

When you first start using Movavi Screen Recorder, you need to activate the codecs you are using. Simply click **Activate** in the message box to start using these codecs and continue with your capture. This process is free of charge and does not collect any personal information.
Recording online video
How to capture videos from YouTube, Vimeo, and other websites

Step 1: Select capture area
1. On the recording panel, click the Select capture area button.
2. The screen will dim and a magnifying glass will appear.
   • For high-quality videos, we recommend recording in full screen mode. To select the entire screen, click the full screen button.
   • For low-quality videos, draw the capture area on top of the web player.

Step 2: Enable system sound
1. Click the System Audio button to enable sound recording.
2. Use the slider to the left to set the necessary system audio volume.

Step 3: Record the video
1. To ensure the best recording quality, set the online video player to the highest quality and wait for the video to load.
2. Click the REC button to begin recording.
3. You will be given a 3-second countdown before recording starts. Use this time to enable full screen mode and start the video.
4. When the video ends, use the F10 keyboard shortcut to finish recording, or click Stop on the recording panel.

Step 4: Cut and convert the video (optional)
Your video is now ready. When you end the recording, you can play the finished video, cut out unwanted parts, or save it in a different format.

Trimming the video
If you’ve recorded extra bits at the beginning or at the end of the video:
1. Place the position marker to where you want to cut the video.
2. Click the scissors button to cut at the selected time.
3. Select the fragment you’ve cut and click the trash can icon to delete it.
Saving the edited video
After you finish capture, your recording is already saved in MKV format. If you've cut the video or want to change the format, you will need to save a copy of the video.
1. Click the Save As button in the editing window. The output options will appear.
2. Name your file and click the button in the Save to box to choose where to save the video.
3. Choose the format for saving the new video.
4. Click Save to begin processing your recording.
Recording with webcam
How to add a simultaneous webcam overlay to your videos

Step 1: Select capture area
1. On the recording panel, click the Select capture area button.
2. With the crosshair, select the part of the screen that you want to record.

Step 2: Set up the webcam
1. Connect the webcam to your computer and wait until the system installs the necessary drivers.
2. Click the cogwheel icon on top of the Webcam button. The webcam preferences will open.
3. Under Use this webcam, choose the webcam device that you want to use and check that its preview appears on the right.
4. Set up the video options for this webcam:
   • Click the Settings button to set up your webcam’s options such as brightness, contrast, and exposure. Note: webcam settings are different for each model.
   • Choose the resolution that you would like to use. The higher the resolution, the higher the webcam video quality will be. However, if the webcam video is small, you may not need a very large resolution.
   • For the best quality, use the highest frame rate that your webcam can provide for the best quality. If your webcam is mostly static or if you want a smaller file size, you may want to use a lower frame rate.
5. Set up the size and position for your webcam:
   • Use the Video size slider to set the size of the webcam picture relative to the entire video.
   • Choose one of the Position options to place your webcam picture inside the frame.
6. Click OK to save the webcam preferences.
Now that you've set up the webcam, the next time you want to use it, simply click the **Webcam** button once to enable webcam recording.

**Step 3: Set up sound**

Next, choose the audio sources that you want to hear on your recording:

**System sounds**
To record music and other sounds playing on your computer, click the **System Audio** button. The button appears green when enabled.

**Microphone**
You can record audio from your webcam's built-in microphone, or use an external microphone for better sound quality:

1. Click the **Microphone** button to enable recording from external devices.
2. Click the arrow above and choose the microphone you want to use from the list.

**Step 4: Record your video**

When you're ready to begin, click **REC** to start recording. The recording panel will be minimized during recording.

To finish the recording, press **F10** or click **Stop** on the recording panel.

**Step 5: Edit and save**

When the recording is finished, it will open in the capture editor, where you can play or trim the result.

To cut or trim the video, use the **scissors** and **trash can** buttons on the toolbar. If you've trimmed the file or if you want to save your recording in a different format, click **Save As**.
Recording video from players

Before you start:
Note the quality and resolution of your video. For best video quality, it is recommended that you record the video as close to its real resolution as possible.
• If the video is larger than your screen, maximize the player window and record the full screen.
• If the video is smaller than your screen, set the player settings to display the actual size. In this case, stretching the video to the full screen will decrease the quality.

Step 1: Select capture area
1. On the recording panel, click the Select capture area button.
2. With the crosshair, select the part of the screen that you want to record.

Step 2: Set up the sound
1. To enable recording sounds from the player, click the speaker button under System Audio. The button will appear green when enabled.
2. Use the slider to the left of the speaker button to set the volume of the player’s recording.
3. To make sure that other sounds don’t interfere with your recording, check that the Microphone button is disabled (black), and close other windows or browser tabs that might play sounds during your recording.

Step 3: Record video
When you’re ready, click the REC button on the recording panel and start playback in the player. The recording panel will hide.
Tip: You can trim the beginning later, so don’t worry if you start playback after recording has begun.

To end the recording, press F10 or click Stop on the recording panel.

Step 4: Edit and convert (optional)
Your recording is ready and saved in MKV format, and you can view the result in the capture editor. Now, you can trim the video or convert it to a different format.
1. To trim the video from the beginning or from the end, move the position marker to where you want to trim the video and click the scissors button to cut off the fragment. Then, select the unwanted fragment and click the trash can button to delete the fragment.
2. Click the **Save As** button to open output options.

3. Under **File name**, enter a name for the new video. Then, click the button under **Save to** and choose where you want to save the video.

4. Select the format you want to save the recording in.

5. Click **Save** to start processing the new file.

**Troubleshooting**

Some video player programs have video output settings that prevent capturing video and taking screenshots. If you are having trouble recording video from any of the following players, follow the steps to change the player’s settings and enable video capturing.

**Capturing video from VLC (VideoLAN Media Player)**

*(for Windows XP users)*

1. In VLC player, open the Tools menu and choose Preferences.
2. Switch to the Video tab (in Simple mode)
3. In the **Display** section, find the **Output** list. If **DirectX (DirectDraw) video output** is selected, try using a different output mode.

**Capturing video from Media Player Classic**

*(for Windows XP users)*

1. In Media Player Classic, open the **View** menu and select **Options**.
2. Go to the **Playback > Output** section in the tree on the left.
3. Find the **DirectShow Video** option. Here, you can choose from a list of video renderers that will affect how the player displays video on your screen. If the **Overlay Mixer Renderer** is selected, select any other renderer from this list.
4. Click **OK** to accept the changes.
Capturing video from Windows Media Player
(for Windows XP users)
1. In the main player menu, open the Tools menu and select Options.
2. In the Options window, switch to the Performance tab.
3. Click the Advanced button.
4. In the Video Acceleration section, find the Use overlays option and deselect it.
5. Click OK to accept the changes.
Recording Skype calls

When you record audio or video calls using Skype™ or a similar program, it is important that you record both ends of the conversation. To do that, you will need to record input from your microphone or webcam, as well as the audio from your speakers. Follow the steps below to record Skype calls with audio.

Step 1: Select capture area
1. Launch the Skype application and make sure it is on screen.
2. On the recording panel, click the Select capture area button.
3. Your cursor will turn into a crosshair. Draw a rectangle inside the Skype window where your call video will be.

Step 2: Set up the sound
1. Click the speaker button under System Audio to enable recording sounds on your computer, including the call from the other end. The button appears green when enabled.
2. Click the Microphone button to enable recording from a microphone. If you have more than one microphone, click Microphone and choose the one you want to use for the recording.
3. Use the sliders to the left of each button to set the necessary volume levels for the call and for your microphone.

Tip: if you're recording a video call, you do not need to enable webcam recording in Movavi Screen Recorder, because Skype is already recording your webcam.

Step 3: Record your call
1. Start your call in the Skype window.
2. Click REC on the Movavi Screen Recorder panel to begin recording.
3. When you finish your call, press F10 or click the Stop button on the recording panel to finish recording. The capture editor will appear, where you can play the finished video, cut the recording, or save it in a different format.

Step 4: Edit and convert (optional)
If your recording started before the call, you can trim off the extra bits using the scissors and trash can buttons.

1. Place the position marker to where you want the video to start and click the **scissors** button.

2. Select the unwanted fragment and click the **trash can** button to delete it.

3. Now that you’ve cut the video, you need to save the trimmed copy. To do that, click the **Save As** button.

4. The export options will open in a new window. There, select the format you want to use, name the file and choose where you want to save it, and click **Save** to start processing the video.

*Tip: If you want to save just the audio of the call without the video, go to the Audio tab and select MP3.*
Making an animated GIF

To create a GIF, all you need to do is record an action or video on the screen and then save the animation in the GIF format.

**Step 1: Select capture area**
1. Click the **Select capture area** button on the recording panel. Your cursor will turn into a crosshair.
2. Draw a rectangle with your mouse to select the area that you want to record.

If you need to adjust the capture area, drag its edges to change the size and drag the circle in the center to change its position.

**Step 2: Record the action**
Once everything is ready, click the orange **REC** button to begin recording your GIF.

When you've finished your recording, press **F10** or click **Stop** on the control panel. Don't worry if you accidentally record more than you need, you can trim the recording later.

**Step 3: Trim and save your GIF**
After capture is complete, you will see your recording in the capture editor window.

**Trimming the GIF (optional)**
If you've recorded extra bits, you can cut them off:
1. Place the position marker to where you want to cut the video.
2. Click the **scissors** button to make a cut.
3. Select the fragment you want to remove and click the **trash can** button.
Saving the GIF
1. Click the Save As button to open output options.
2. Name your GIF file and choose where you want to store it.
3. Click the GIF square to choose GIF as the output format.
4. Click Save to start turning the recording into an animated GIF.

Fun fact!
The creators of this format intended it to be pronounced as ‘jif’, but it is now more common to pronounce it with a hard ‘g’, so both pronunciations are accepted.
Record audio only

Recording music or voice with Movavi Screen Recorder

Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.

Step 1: Set up the audio
On the recording panel, choose which audio sources you want to record from:

- **Recording system sounds**
  To record music, online videos, and any other sounds playing on your computer, click the System Audio button.

- **Recording microphone audio**
  To record sound from a microphone or any other recording device connected to your computer, click the Microphone button. If you have more than one recording device, click the arrow above the button and select the device you want to record from.

- **Volume levels**
  Use the sliders to the left of the System Audio and Microphone buttons to adjust the volume of each source.

Step 2: Record the audio
Click REC when you’re ready to begin recording.

Step 3: Save audio file
When the recording is finished, the capture editor window will appear, where you can play the audio you’ve recorded.

1. Click Save As to open the exporting options.
2. To save just the audio from your recording, go to the Audio tab and click MP3.
3. Click Save to turn your recording into an audio file.
Troubleshooting audio

*My device is not available in the list.*

If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.

1. Try re-connecting the device.

2. If that didn't help, right-click the sound icon in the Windows notification area and choose *Recording Devices* from the pop-up menu. The Sound settings window will open.

3. Look for your device in the list:
   - If the device is working correctly, it should be marked with a green checkmark.
   - If you cannot find the device in the list, right-click anywhere in the list and make sure that the options *Show Disabled Devices* and *Show Disconnected Devices* are selected.
   - If you still cannot find the device, download a driver for this device from the manufacturer’s website and install it. This should help your system detect the device.

4. Try enabling the device:
   - If the device is listed as *Not Plugged In*, try plugging in the device again.
   - If the device is listed as *Disabled*, right-click the device and choose *Enable*.

*I can’t enable system audio*

If you’re using Windows XP, system audio cannot be recorded simultaneously with microphone audio. To record system audio, open the list of devices above the microphone button and choose *Stereo Mix*. 
Setting up a screen recording

Recording panel
You can use the recording panel to set up your recording.

Learn more: Capture area

Sound
You can record sound from two different sources on your video: from your speakers, or from an external device, such as a microphone.
• Click the speaker button to record system audio,
• Click the microphone button to record from a microphone.
Learn more: Sound

Webcam
You can simultaneously record your webcam footage that will show up in the corner of the video. Connect the camera and click the Webcam button on the recording panel.
Learn more: Webcam

Cursor recording
If you're making an instructional video, you can highlight the cursor and its clicks to help your viewers keep track of your mouse. You can change the appearance of your cursor in the Effects section of the Preferences.
Learn more: Mouse cursor effects

Keystroke recording
If you're showing keyboard actions such as hotkeys on your video, you can enable keystroke recording, and the keys you press will automatically appear at the bottom of the video. You can enable keystroke recording in the Effects section of the Preferences.
Learn more: Recording keystrokes

Scheduling recordings
When you've finished setting up your recording, you can start it right away or schedule it to begin or end automatically. You can schedule your recordings in the Capture Time section of the Preferences.

Starting the recording
To start recording right away, click the REC button on the recording panel. You can pause and end capture using the buttons on the recording panel.
Learn more: Starting the recording
Capture area
The orange frame defines which part of your screen will be visible in your screen recording.

Selecting the capture area
Step 1: Click the Select Capture Area button on the recording panel. To record the entire screen, click the full screen button.

Step 2: For custom area selection, your cursor will turn into a crosshair. Use it to select the part of the screen that you want to record.

• To record a window or a window panel, hold your mouse pointer over the window you want to record and click when a frame appears around it.
  Tip: if you select a window, the capture area will follow whenever you move the window.

• To record a part of the screen, click and drag diagonally to draw the area where you want it to appear.

Setting an exact size
• For custom area selection, you can enter an exact size into the width and height boxes;

• For full screen as capture area on two or more monitors, open the list and choose DISPLAY.

Editing the capture area
• To change the capture area size, drag the edge of the capture area with your mouse.

• To move the capture area, drag the circle in its center.
Sound
You can record sound from two separate sources: system audio and microphone audio. You can enable sound recording on the recording panel.

System audio
System audio is the sound that you can hear from your speakers. It includes music, video sound, alerts, and all other sounds.

1. To enable recording system audio, click the speaker icon on the recording panel.

2. Use the slider to the left of the speaker button to change the system audio volume. This will also affect the volume that you hear.

Microphone audio
To record from a microphone or any other external recording device:

1. Connect the microphone to the computer. Make sure that it is recognized by the system and working correctly.

2. Click the microphone icon on the recording panel to enable microphone recording.

3. If you have more than one recording device connected, click the arrow next to Microphone and choose which microphone you want to use.

4. Use the slider to the left of the microphone button to change the volume.

When enabled, the sound icons appear green.
Troubleshooting

Capturing system sound on Windows XP

Windows XP does not support recording from multiple audio sources. You can either record microphone audio or system audio, but not both. To record system sound on Windows XP:

1. Click the microphone button to enable recording from audio devices.
2. Click the triangle next to Microphone and choose Stereo Mix from the list of devices.

Please note that not all hardware allows stereo mix recording.

See also:

Recording only audio
Recording Skype calls
Webcam
You can record webcam video simultaneously with a screencast. The webcam video will appear in the corner of the main video.

Enable the webcam
To enable webcam recording, click the webcam icon on the recording panel:

Webcam options
If this is your first time recording with a webcam, you may want to set up how the webcam looks on your video. To open the webcam options, click the cogwheel icon on the webcam button.
Or open the Settings menu, choose Preferences, and then switch to the Webcam tab.

If you have more than one camera, choose the one you want to use under "Use this webcam".

Webcam properties
Click the Settings button to open your webcam’s built-in properties. These can be different for each manufacturer, but usually you can set up the brightness, white balance, exposure, and other color options.

Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in quality.

Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30 frames per second.

Video size
Use the video size slider to change the size of the webcam video relative to the main video.

Position
You can place your webcam footage in any of the four corners of the main video. Choose where to place the webcam video under position.

See also: Webcam preferences
Mouse cursor effects

Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.

**Step 1: Open the mouse cursor options**
1. Click the **Settings** menu and choose **Preferences**.
2. In the Preferences window, switch to the **Effects** tab.

Learn more: **Effects options**

![Preferences window with Effects tab open](image)

**Step 2: Enable the cursor**
Select **Show cursor on recording**. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.

![Enable cursor](image)

**Step 3: Highlight cursor actions (optional)**
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.

**Highlight cursor**
A semi-transparent circle will appear around the cursor, making it easier to track.

1. Select the **Highlight cursor** option.
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
3. (optional) Use the **Size** slider to make the highlight smaller or larger. The cursor itself will remain the standard size.

Hover your mouse over the square on the right to preview the highlight.
Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons.

1. Select the **Highlight clicks** option.

2. (optional) Click the left square to set the color for the left mouse button.

3. (optional) Click the right square to set the color for the right mouse button.

Mouse click sound
A clicking sound will play whenever you click the mouse.

1. Enable the **Mouse click sound** option.

2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and choose **Add sound**. Then, open the sound file that you want to use. 

   *You can use WAV, MP3, AIFF, and AU files.*
Recording keystrokes

If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to show the keys you pressed at the bottom of the video.

1. Open the Settings menu.

2. Choose Preferences.

3. In the Preferences window, switch to the Effects tab.

4. To enable keystroke recording, select one of the options:
   • Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will show up on screen. Letters and keys that do not cause an action will not be displayed.
   • All keystrokes — each key you press will appear on screen, including letters and numbers.

To turn off keystroke recording, open the Effects preferences once again and select Do not capture keystrokes.

Tips:
• Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if you share the video, your viewers will be able to see each character you type.
• Keyboard shortcut recording does not work with the Windows key.
Scheduling

Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.

**Step 1: Set up your recording**

Scheduled recordings will start with the currently selected options (system sound, webcam, etc.) Before scheduling the recording:

1. (optional) Default capture area for scheduled recordings is full screen, so if you want to change it, click the Select Capture Area button on the recording panel and select the part of the screen you want to see on your scheduled recording.

2. To enable system sound recording, click the speaker button on the recording panel and make sure it is enabled and highlighted green.

**Step 2: Schedule recording**

1. On the recording panel, click the alarm clock button to open capture time settings.

   *Or open the Settings menu, choose Preferences and switch to the Scheduler tab.*

2. Select Schedule recording.

3. Click the Add Task button.

4. A task template will appear. Fill in the details for the task:
   - **Title** - the name of your recording
   - **Date and time** - the moment recording should start
   - **Duration** - how long the recording should last (e.g. if you want to record an hour long webinar, set this at 01:00:00)
   - **Capture area** - by default, the program will record full screen. However, if you’d like to avoid recording extra parts of the screen, you can select Current area. Be careful: the program will capture the area selected on screen at the moment your recording starts!
   - **After capture** - you can set your computer to automatically sleep or shut down when the recording is over.

Learn more: [Capture area](#) | [Sound](#) | [Webcam](#)
5. Click **Create** to add the task to your recording schedule.

**Step 3: Enable launching at startup (optional)**
The screen recorder needs to be running at the scheduled start time to begin the recording. If you’ve scheduled the recording for a later date, enable the program to start with your computer so that you don’t miss the recording. To do that, open the **General** section of the Preferences, click **More** and enable the **Launch application at startup** option.

Finally, click **OK** in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in *.mkv* format in the output folder with your other screen recordings.

*Please note that if you haven’t yet activated the program, the maximum capture time is 5 minutes for each video. To learn more about activating Movavi Screen Recorder, see the Activating Software section.*

*If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.*
Time limit

When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is up. This way, you don’t have to wait around for the video to end.

Setting time limit before recording

1. On the recording panel, click the **alarm clock** button to open capture time settings.

   Or open the Settings menu, choose Preferences and switch to the Capture Time tab.

2. Select the **Set time limit for recording** option.

3. Set **Duration** by entering the time limit as hours:minutes:seconds.

4. Click **OK** to enable the time limit.

   *Note: the limit will work on all your next recordings in the current session only, until you restart the program.*

5. Click the **REC** button on the recording panel to begin recording. After the specified time is up, the recording will end automatically.

Setting time limit during recording

1. On the recording panel, click the **alarm clock** button to open time limit settings.

2. Set the **time** after which the recording should finish.

3. Set up actions after capture (Do nothing, Sleep, or Shut Down).

4. Click **OK** to apply the settings and enable the time limit.
After that, the countdown will begin. Click **Reset Time Limit** to cancel the auto finish. You will have to stop the recording manually.
Starting the recording

To begin recording:
To begin recording, do any of the following:
• Click the REC button on the control panel.
• Use the start recording keyboard shortcut (F10 by default)
• In the system tray, right-click the Movavi Screen Recorder icon and choose Start Recording.

You will be given a 3-second countdown before recording begins.

The recording panel will change during capture:

On the left, you can see information about the recording:
Duration – the time recorded so far
Recorded – the recording size on disk
Left on Disk – how much free disk space you have left

In the middle, you can see which devices are being recorded:
学科 – Webcam off/on
学科 – System audio recording off/on
学科 – Microphone audio recording off/on

To pause recording:
To pause recording, do any of the following:
• Click the Pause button on the recording panel.
• Click the Pause button on the orange panel at the top of the capture frame.
• Use the pause capture keyboard shortcut (F9 by default)
• In the system tray, right-click the Movavi Screen Recorder icon and choose Pause.

When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.

To stop recording:
When you're ready to finish the recording, do any of the following:
• Click the Stop button on the control panel.
• Click the Stop button on the orange panel at the top of the capture frame.
• Use the stop recording keyboard shortcut (F10 by default)
• In the system tray, right-click on the Movavi Screen Recorder icon and choose Stop Recording.

The recording will end and the player window will open, where you can view and edit the video.

Troubleshooting:
Windows style changes when I start recording
If you have a Windows Aero theme (Windows Vista, Windows 7), disabling the transparency effects will free more resources and your computer will run faster during capture. The Aero theme will return once you have finished capture. To disable this, open the Preferences and turn off the 'Disable Aero theme during capture' option in General preferences.

Capture doesn't start immediately
By default, you will see a three-second countdown after you press the REC button and before the recording begins. You can use this time to prepare for recording. If you want the recording to start immediately, open the Preferences and enable the 'Disable countdown' option.

An orange panel appears on my recording
During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording, and keep track of the recording process. If you don't want this panel to appear on your videos, open the Preferences and disable the 'Show capture control panel during recording' option.
Editing captured files
When you end a recording, the player window will open, where you can view the finished video, save videos to a different format, and edit videos and screenshots.

Here's what you can do:
- **Cut recordings** – trim videos from the beginning or the end, cut out fragments.
- **Change recording format** – save the video in a different video format, as an audio file, or even as an animated GIF.
- **Publish online** – upload the video straight to YouTube.
- **View previous recordings** – all your earlier recordings and screenshots in one place on the history panel.
Opening the player

To open the capture player and editor:

• Open the Media Files menu and select Preview Recorded Videos.

• Right-click the Movavi Screen Recorder icon in the notification area and select Preview Recorded Videos.

Also, the capture editor will open after you finish recording a video.
Opening previous recordings

After you've finished a recording, it will open in the capture editor, where you can view and cut the file. If you want to edit the recording later, you can open a recording file using any of the following:

Recent recordings

At the bottom of the capture editor, you can see a carousel of your previous recordings and screenshots. If you can't see the thumbnails, click the Recent button in the bottom left to show the panel.

Tip: If you've changed the recording folder in File preferences, the Recent panel will only show recordings in the new folder.

Open a file
Open the Media Files menu and choose Open Recording File. Then, find the file in the Explorer dialog box and click Open.

Storage location
The default locations for saving output files are:

- "Videos\Movavi Screen Recorder" – for video recordings
- "Videos\Movavi Screen Recorder\Screenshots" – for screenshots

To change where the files are stored:
1. Open the Settings menu and choose Preferences.
2. In the Preferences window, switch to the Files tab.
3. To change the video storage folder, click the ellipsis button next to Save output videos to and choose a new folder.
To change the screenshot storage folder, click the ellipsis button next to **Save screenshots to** and choose a new folder.  
4. Click **OK** to accept the changes.
**Cutting recordings**

This guide will show you how to cut out parts from video recordings using the built-in capture editor.

**Before you start:**
- Open the recording you want to edit in the capture editor.

**Step 1: Cut fragments**

1. Move the position marker to where you want to cut the video.

2. Click the scissors button. A cut marker will appear at the current position.

Repeat these two steps to cut at the beginning and at the end of each fragment you want to delete.

**Precise positioning**

For more precise positioning, click on the cut marker on the seek bar and do any of the following:
- Click the previous frame and next frame buttons to move the cut marker by exactly one frame,
- Click the arrows next to the time to move the marker by a small interval.
- With the cut marker selected, use the arrow keys to move it left or right by 100 milliseconds.
- Manually enter the necessary time.

**Step 2: Delete fragments**

1. On the seek bar, click a fragment to select it. The selected fragment appears as a darker shade.

2. To delete the selected fragment, click the trash can button.

A dotted line will appear on the seek bar where a fragment has been deleted.
How to undo cutting
To cancel a cutting action, click **Undo** or press **Ctrl+Z**. To repeat a cancelled action, click **Redo**.

**Step 3: Save the edited video**
If you've cut the video, you need to save it to apply the changes.

1. Click **Save As**. The window with saving options will appear.
2. At the top of the window, choose where to save the file and enter a file name.
3. Choose a format for the video. If you don't know which format to choose, leave MP4 selected. It will save faster and at no quality loss.
4. Click **Save** to start processing the video. This may take a while for longer videos.
Changing the format
New recordings are created in the MKV format which is supported by most players. This guide will show you how to save your video recordings in a different format. You can also convert your video recordings to audio by saving them as an audio format.

Before you start:
• Open the recording that you want to change.

Step 1: Open the output options
Click Save As to open the output options.

Step 2: Name and location
Enter a name for your new file under File name. If you want to store the recording somewhere other than the default folder, click the ellipsis button next to Save to and choose a different folder.

Step 3: Choose a new format
Select a format you want to use. The formats are organized into three groups:
• Video - MP4, AVI, GIF, MOV, MKV
• Audio - MP3
• Devices - iPhone, iPad, Android

Step 4: Save the file
Finally, click Save to convert your recording to the selected format. This may take a while for large videos.
Advanced settings

There are some extra settings you can use to customize your recorded files before saving. To open the settings, click Advanced in the saving window.

Resolution
The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common resolutions. Ideally, the frame size should not exceed the resolution of the recorded video, but match it instead. Smaller resolutions allow you to make the output video smaller and thus save your disk space, however, this will sacrifice some video quality due to downscaling.

Framing
Choosing a resize method can help you manage how your video is resized to fit inside the frame size you've set. There are three resizing options available:

Letterbox – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame without distortions, but may place black bars around the video.

Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving black bars. This allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.

Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire area of the frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips where important objects are near the edge of the frame.

FPS
The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan on using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.

Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.

**Channels**

**Stereo** sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording music; **mono** sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred number of channels, however, some mobile devices record sound only in mono mode.
Once your video is ready, you can share it to YouTube!

**Step 1: Open the Export window**
Click the Share button next to Save As and select YouTube.

**Step 2: Sign in to your account**
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Recorder upload videos.

**Step 3: Choose a resolution**
In the export window, open the Resolution list and choose a resolution that suits your video.
• For best results, choose a resolution that is equal to or less than the height of your video. For example, if your video is 1280x720, choose the 720p resolution.
• This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the website.
Step 4: Fill in the details
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
   • Private – only you can see the video.
   • Unlisted – the video will not appear for other people unless you give them the link.
   • Public – anyone can access the video.

Step 5: Save and upload the video
1. Before uploading, you can save the video to disk to keep all the editing and settings. To do that, enable the Save to box. To change where the video file is stored, click Browse and select a folder.
   Hint: by default, the option is disabled. Remember: the original recording is automatically saved in the MKV format in your output folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify your account.
   YouTube help – increasing your upload limit
3. Click Start to begin saving and uploading the video.
Uploading videos to Google Drive

You can use Google Drive to store your videos or share them with others.

**Step 1: Open the Export window**

1. Click the **Share** button next to Save As.
2. Select **Google Drive**.

**Step 2: Sign in to your account**

1. Click **Sign In**. The authentication page will open in your browser.
2. Sign in to your account and click **Allow** to let Movavi Screen Recorder upload videos.

**Step 3 (optional): Select your Google Drive folder**

After you’ve signed in, the program will load your Google Drive folder list. You can share files to specific folders if you like. Select one of them in the list.
Step 4 (optional): Choose a format
By default, MP4 is suggested. You can change the format and upload files in various formats, including GIF, MP3, and other. Learn more: Changing the format

Step 5: Fill in the details
1. Fill in the title for your video.
2. Choose who you want to see the video under Privacy:
   - Only me – only you can see the video.
   - Get shareable link – the video will not appear for other people unless you give them the link.

Step 6: Save and upload the video
1. Before uploading, you can save the video to disk to keep all the editing and settings. To do that, enable the Save to box. To change where the video file is stored, click the ellipsis button and select a folder.
   *Hint: by default, the option is disabled. Remember: the original recording is automatically saved in the MKV format in your output folder.*
2. Click Start to begin saving and uploading the video.
Uploading videos to Movavi Cloud
If you only need to quickly share a file, you can use Movavi Cloud. It will give you a shareable link in just one click!

1. In the editor window, click the Share button and select Movavi Cloud. The upload will start immediately.

2. Share! The link will be copied to clipboard automatically, but you can also use the copy button or click View in Browser to open the file in your default browser.

In the browser, you can play the video or download it. The file will be accessible by the link, so if you feel you might need to send it to someone else some other time, make sure to know where to find it (e.g. in a message you’ve first attached it to).
Taking screenshots
Capturing screenshots with Movavi Screen Recorder

Step 1: On the recording panel, click the screenshot button.

Step 2: Your cursor will turn into a crosshair. Select the part of the screen that you want to capture:
- To capture a window or a window frame, hold your mouse pointer over the window and click after a frame appears around it.
- To capture a part of the screen, hold the left mouse button and drag diagonally to draw a rectangle.
- To capture the entire screen, click on any empty area of your desktop.

Step 3 (optional): A frame will appear over the selected area. You can now edit your screenshot:
- Select a tool you want to add to your screenshot: Line, Arrow, Tapered Arrow, Frame or Highlighter. Hold the left mouse button and drag to draw a shape.
- Click Tool Properties to change the color and width of your shape.
- Drag by the green arrow circle or the white circles on the edges to resize the element; rotate by dragging the green circle left or right.
- If you need to move the capture area, click the Drag-area mode button.
Step 4: Choose what you want to do with your screenshot:

- Click the **Copy** button to copy the image to clipboard without saving the screenshot to a file.
- Click the **Save** button to save the image file and open its containing folder.
- Click the **Share** button to share the image to Movavi Cloud or Google Drive.

Where are the screenshots stored?

By default, the screenshots are stored in the "Videos\Movavi Screen Recorder\Screenshots" folder of your user. You can change where the files are saved in the Files section of the Preferences. To open the screenshot's location, click the Show in Folder button on the top panel of the editor window.
Screen Recorder preferences

To open the program settings for Movavi Screen Recorder:
1. Open the Settings menu.
2. Choose Preferences.

The preferences window will open. The preferences are organized into eight categories: General, Files, Keyboard Shortcuts, Video, Webcam, Effects, Scheduler and Sharing.
General preferences
The General tab allows you to change the basic behavior of the program. The settings are organized into two groups for your convenience.

Basic settings

- **Disable countdown**
  Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this option to turn the countdown off and start recording immediately.

- **Hide control panel above capture area frame**
  The capture control panel will appear on top of the capture frame while recording a video. You can use it to pause or stop capture, take a snapshot, or see how much space the recording has taken up. If you are recording a full screen video, the panel will not be visible.

- **Hide control panel inside capture area frame**
  Another capture control panel appears inside the capture frame, on the bottom left of it, while recording a full screen video. It's semi transparent and it will not be recorded on top of your finished video, but you can hide it if necessary.

- **Disable frame blinking during capture**
  In case the blinking irritates you, check this box. The frame will stay still during recording.

- **Allow window panes selection**
  To record only the main window panes (no frames, menus or browser tabs), Movavi Screen Recorder needs access to your screen.

- **Capture separate streams**
When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers. This can be useful for editing the video later, so you can edit them separately.

- **Enable sound notifications**
The program will notify you when a screenshot has been taken, a file export is finished, or if an error occurs.

### Other settings

- **Launch application at startup**
  With this option enabled, Movavi Screen Recorder will start when you log in and run in the background. This way you will always be ready to capture your screen.

- **Use software OpenGL implementation (advanced)**
  This option can troubleshoot OpenGL problems for some graphics cards.

  OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

- **Save extended logs for troubleshooting**
  In case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the program's actions for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of information which may be essential to solving your problem.

- **Automatically check for updates**
  The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major updates users with purchased Movavi Screen Recorder license will get a considerable discount.

- **I give consent to send anonymous usage stats to Movavi**
  Enabling this box will allow Movavi Screen Recorder to send us anonymous data about how you use the program. This data does not contain any personally identifiable information and is only used for improving our software. You can find more information about how we use the statistics on our Movavi Improvement Program page.

- **Disable Aero theme during capture**
  Windows Aero themes that use transparency require more processing power. This may slow down your computer while recording video. With this option enabled, the program will disable the Aero theme while recording to improve performance. The theme will be restored after recording has finished.

  *(For Windows Vista and Windows 7)*

- **Use DirectX for capturing**
  Try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is chosen automatically and this option is unavailable.

  *(For Windows 7 and earlier)*

- **Use alternative capture mode**
  If you get an error message when you start or stop recording your screen, try this option.

  *(For Windows 8 and above)*
File preferences
In the File section of the preferences, you can change where your captured files are stored. To change a folder location, click the icon with the dots and select a new folder:

- Save output videos to...
  This is where all your video recordings are saved.

- Delete original recording after saving
  If you save the recording in a different format, or trim the file, the original will be deleted.

- Save screenshots to...
  This is where all your new screenshots are saved. You can also find your recent screenshots in the editor window.

- Default screenshot format
  Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button in the editor window to save a copy with a different format.
Keyboard shortcuts

The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On the right, you can see keyboard shortcuts for every action.

To change one of the shortcuts:

1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom shortcut.
3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.

If there’s a keyboard shortcut you want to use in other software while Movavi Screen Recorder is running, check the Disable keyboard shortcuts box.

In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.
On the **Video** tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate, number of channels, and bits per second.

**Frame rate**
The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame rate will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per second.

**Sample rate**
The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record sound. Higher sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human hearing range.

**Channels**
- **Mono** uses only one audio channel, which saves some disk space.
- **Stereo** uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

**Bit depth**
Screen Recorder will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample contains 16 bits of information to encode sound.

- **Enable SuperSpeed conversion**
  This option will make saving videos faster if you use the same output video codec. For example, if you cut the video without changing the format. Formats that work with SuperSpeed are marked with these icons: ![SuperSpeed](https://example.com/super_speed_icon.png)
  in the list. If you’re having problems with saving some files, try disabling this option.

- **Enable Intel hardware acceleration**
  This option will make saving videos faster if your computer is equipped with a compatible Intel® graphics chip. Intel acceleration works when processing H.264, MP4, and MPEG-2 videos.

- **Enable NVIDIA GPU acceleration**
  This option can make saving videos faster by using the graphics card to process media files. This leaves the CPU free for other tasks and improves performance while saving videos. This option is only available if you have an NVIDIA® graphics card compatible with the NVENC® or CUDA® technologies.

- **Enable AMD acceleration**
  This option is meant for the same purpose as the ones above: it allows to save videos faster, too, but this time you need an AMD graphics card to use the acceleration.
Webcam preferences

The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video.

Enabling the webcam
1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the 'Use this webcam' box.

If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the right to check that the camera is working properly.

Webcam properties
Clicking the Settings button will open the camera’s properties. These properties are different for each manufacturer, but generally you can use them to calibrate the brightness, contrast, and exposure of your camera.

Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in quality.

Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30 frames per second.

Video size
Use the video size slider to set the size of the webcam overlay relative to the main video.

Position
Use one of the position options to choose where your webcam overlay will be placed on the original video.
Effects

In the **Effects** section of the preferences, you can set up the visibility of your mouse and keystrokes.

![Effects section of the preferences](image)

**Cursor options**

Select **Show cursor on recording** to make the cursor visible to your viewers.

- **Highlight cursor**
  
  This option will add a bright circle around the mouse cursor to make it more visible.
  
  1. Select the **Highlight cursor** option.
  2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
  3. Use the size slider to change the size of the highlight circle.
  
  *Hint: hover your mouse over the preview square on the right to see how it will look on the recording.*

- **Highlight clicks**
  
  This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
  
  1. Enable the **Highlight clicks** option.
  2. Click the left square to set the color for the left mouse button.
  3. Click the right square to set the color for the right mouse button.

- **Mouse click sound**
  
  A clicking sound will be played every time you click the mouse to draw attention to your actions.
  
  1. Enable the **Mouse click sound** option. The default mouse click sound will be used.
  2. (optional) If you have a file with a different sound effect you want to use, open the box under **Mouse click sound** and choose **Add sound**. Then, open the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.

**Keystroke recording options**

- **Keyboard shortcuts only** – only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
- **All keystrokes** – all key presses, including letters of the alphabet, will appear on the video.

*Hint: avoid entering passwords when this option is enabled if you don’t want everyone to see your password.*
Scheduler

In the **Scheduler** section of the preferences, you can start and stop recordings automatically.

**Automatically ending a recording**

1. Select the "Set time limit for recording" option.
2. Enter the duration of the recording as hours: minutes: seconds.
   
   Learn more: [Time limit](#)

**Scheduling a recording**

To start and end a recording automatically:

1. Select the "Schedule recording" option.
2. Click "Add Task" button.
3. Fill in the details and click Create to add your task to the recording schedule.

   Learn more: [Scheduling](#)

The Screen Recorder application must be running at this time for the recording to begin. To make sure you don't miss it, enable the "Launch application at startup" option in the **General** section.
**Sharing preferences**
The **Sharing** tab allows you to manage your YouTube and Google Drive accounts used to upload videos to.

To sign in to your account:
1. Click **Sign in**. The authentication page will open in your browser.
2. Sign in to your account and click **Allow** to let Movavi Screen Recorder upload videos.
Help and support

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

**How to reach us**
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!

If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information about your system will allow us to help you faster.

Frequently asked questions

**Why is “Trial Version” written on my videos?**
The watermark is only placed on videos in the trial version. Buy an activation key and use it to activate the program. After that, you can convert files without the watermark.
Removing trial restrictions

**Why do I have to activate codecs?**
Some video and audio codecs are patented by other organizations and need to be activated. Activation is free of charge and you will only need to do this once for each patented codec. You may encounter the activation messages when starting capture or opening captured files. When you activate the codec, the program sends your consent to our server. If you don't want to see these messages, select **Activate other codecs without asking**, and future codecs will be activated automatically.
 Codec activation
## System requirements

<table>
<thead>
<tr>
<th></th>
<th>Minimum system requirements</th>
<th>Recommended configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows® XP*/Vista/7/8/10 with latest service packs and patches</td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>Intel®, AMD® or compatible processor, 1.5 GHz</td>
<td>2.8 GHz or higher multi-core processor</td>
</tr>
<tr>
<td>Resolution</td>
<td>1024x768, 32-bit color</td>
<td>1280x1024 or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Windows XP, Vista – 512 MB</td>
<td>Windows XP – 2 GB</td>
</tr>
<tr>
<td></td>
<td>Windows 7, 8, 10 – 1 GB</td>
<td>Windows Vista, 7,8, 10 – 4 GB</td>
</tr>
<tr>
<td>Available disk space</td>
<td>810 MB for installation</td>
<td>10 GB for recording and media processing</td>
</tr>
<tr>
<td></td>
<td>2 GB for ongoing operations**</td>
<td>Administrator permissions are required for installation</td>
</tr>
<tr>
<td>Additional features</td>
<td>Sound card for audio recording and playback</td>
<td>Intel® hardware acceleration requires a compatible Intel processor supporting Intel HD Graphics™ 2nd generation or higher</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For intended performance, make sure that your graphics card drivers are up-to-date. <a href="#">Updating graphics card drivers</a></td>
</tr>
</tbody>
</table>

* Windows XP does not support recording system sound simultaneously with audio devices.

** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on the resolution, format, and length of your videos.

Movavi Screen Recorder may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not met.
Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply with patent law.

1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.

2. Select the **Activate other codecs without asking** box to activate all codecs automatically in the future. The codecs will be activated automatically, but an Internet connection is still necessary.

3. Click **Activate** to complete the codec activation.

Codec could not be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated even if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.

What kind of data is being sent?
The data we send does not contain any information that can personally identify you. We only receive information about which codecs were used.
### Supported formats

<table>
<thead>
<tr>
<th>Video Formats</th>
<th>Supported Codecs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Video Interleave (.avi)</td>
<td>H.264</td>
</tr>
<tr>
<td>QuickTime (.mov)</td>
<td>H.264</td>
</tr>
<tr>
<td>MPEG-4 (.mp4)</td>
<td>H.264</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Audio Formats</th>
<th>Supported Codecs</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP3 – MPEG-1/2 Audio Layer III (.mp3)</td>
<td>MP3</td>
</tr>
</tbody>
</table>

### Image formats

BMP, JPEG, PNG, GIF
Updating the graphics card driver

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card manufacturer’s website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of applications and games on your computer.

Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution.
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section. Note the full name of the graphics card somewhere for later.

Step 2: Download the new version
Now that you’ve learned your graphics card manufacturer and model, go to the manufacturer’s website and find driver downloads. There, look for the model or series that you’ve found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find the necessary driver.

NVIDIA download center
AMD download center
Intel download center

Warning: Only download drivers from the official manufacturer’s website. Third-party websites offering driver downloads may contain malware.

Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the on-screen instructions to install the driver on your system. Your display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you to optimize your computer’s graphics performance.

1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try the method above.
NVIDIA download center
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and install the necessary driver for your system.

Updating AMD® or ATI® Driver
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD’s official website.
AMD Driver Download Center
2. Download the auto detect utility and run it when the download has finished.
Auto Detect Utility
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and download the driver.
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.

If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have encountered. This will help our support team specialists solve your problem quicker.
OpenGL troubleshooting

If you see the following message about OpenGL when you open Movavi Screen Recorder or you've noticed that the player, filters, or transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Screen Recorder, your computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver installation file from the manufacturer's website and install it following the on-screen instructions.

Detailed instructions on updating the driver

It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Screen Recorder. If you see an error message again, proceed to the next step.

Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:

• In the message you see after starting Movavi Screen Recorder, select the Download and install software OpenGL implementation box.

• Open the Settings menu and choose Preferences. There, select the Use software OpenGL implementation option and click OK.

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi Screen Recorder.

If these steps haven't helped:

• Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.

• Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.
How to collect logs
Providing your log files when you contact support can help us solve your problem faster. The logs contain the program’s actions for some period of time, as well as important error reports and descriptions. The log files do not contain any personal information.

Note that extended logs give the most amount of information which may be essential to solving your problem. To save extended log files, go to General Preferences, click More and check ‘Save extended logs for troubleshooting’.

Step 1: Show hidden folders
1. Open the Control Panel and switch to Small icons view.
2. Click Folder Options.
3. Switch to the View tab
4. Under Hidden files and folders, choose Show hidden files, folders, and drives.
5. Click OK

Detailed instructions

Step 2: Open the Logs folder
1. Go to your system drive (usually Local Disk C).
2. Open the Users folder.
3. Open the folder with your username.
4. There, open the AppData hidden folder.
5. From there, go to Local > Movavi > Logs.

Advanced: you can also simply enter the following into Windows Explorer’s path bar at the top: "C:\Users\USERNAME\AppData\Local\Movavi\Logs", where USERNAME should be your user folder.

Note that the path may vary depending on your Windows version.

Step 3: Send us the logs
1. Find the folder named Screen Recorder 10.
2. Archive this folder and attach this archive to your e-mail, support chat or contact form when you describe your problem.